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Introduction to Dreamweaver  

Dreamweaver – what is it? 
Adobe Dreamweaver is a software application that allows you to create and develop Web sites.  

Dreamweaver is considered WYSIWYG (What You See Is What You Get), meaning that when you format 

your Web page, you see the results of the formatting instead of the mark-ups that are used for 

formatting.  HTML is not WYSIWYG, whereas Microsoft Word is WYSIWYG.  However, Dreamweaver 

allows you to hand code HTML as well.  Dreamweaver also supports CSS and JavaScript as well as other 

languages including ASP and PHP.   

Dreamweaver makes it easy to upload your entire Web site to a Web server.  You can also preview your 

site locally.  Dreamweaver also lets you create templates for your Web site that you can use again and 

again by modifying certain unrestricted areas within the template.  Then if you want to change one 

particular part of your Web site (the logo changes, a main link changes), you only have to modify the 

template for the changes to propagate throughout your Web site.   

Dreamweaver is fairly complex software.  In this lab we will be getting a basic introduction to this 

software package. 

Creating a Web Site: Content 
When designing a Web Site, keep the following in mind: 

1. your overall goal (the purpose of your web site), 

2. your objectives (what information you want your site to convey and how).  

3. your audience (who they are, what they know, what they need to know), and  

When designing your web site, you want to keep in mind the answer to the question, “What is the 

purpose of my site?”  Once you have the answer to that question firmly in place,  you can start worrying 

about the layout of your page.  Start by dividing the content into more and more refined subsections 

that still reflect the purpose of the site.  Connect the sections and subsections such that, as much as 

possible, the connections make logical sense. How you design your Web site should also be influenced 

by your intended audience.  You should always keep in mind what the level of your general audience will 

be, as this expected background knowledge may affect the content as well as the connections you make 

within your Web site.  Your target audience may affect your design in another way – if you expect your 

audience will have older computers and slower internet connections, you will want to be careful about 

what you include on your site other than text. Today we can also add sound, video, and even interactive 

programs to our Web sites, but you need to keep in mind that all of these extras are large in size and 

may significantly slow down how fast your Web site will download . You will also want to plan out what 

links (both links within your own Web site  and links to external Web sites).  Web sites differ from other 

media in that they allow users to choose the content they wish to explore by clicking on links t hat take 

them to new Web pages.  Keep in mind that individuals may be jumping around both within your site 

and out of your site.  If you were to make a particular jump, what links would you want included to 

make your site more navigable? 
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Creating a Web Site: Design 
Now that we’ve got the content structured, we need to think about design.  Let’s start by thinking about 

Unity.  You want your entire Web site to have a uniform look and feel.  Perhaps the colors or the color 

scheme remain the same throughout the site.  Or perhaps the images and layout stay the same, while 

the colors change.  However you choose to show unity, your entire Web site should have a uniform look 

and feel.  When it comes to fonts, unity can be exhibited by using no more than 2 font families – more 

and your site tends to look cluttered and unprofessional.  Unity should also exist between the look of 

your site and the message you are trying to communicate.  Funeral homes rarely use bright, primary 

colors in their color scheme for a reason.   

You also want to keep in mind that your site should be easily readable.  While picking monochromatic  

(colors that are very similar to each other, e.g., blue, blue-green, and green color scheme would be 

monochromatic).color schemes for your web site may be pleasant and have an overall calming feel, 

using a pale green font color on a pale blue background may prove difficult for some people to read or 

follow.  Similarly, having a bright, busy background image may add energy and vibrancy to your web 

page but may also make reading text tiresome and difficult.   

Questions to ask when evaluating a site: 
• Is the purpose of your site clear? 

• Do all of the site’s elements (text, graphics, layout) work together to communicate this 

purpose? 

• Does the flow of the page make logical sense (e.g., in each section, do the subsections logically 

belong to that section?) 

• Do the parts of each section logically belong within the flow of the whole site? 

• Do the links on the page make sense?  Were they included for a reason?  Will they help the 

user to follow content?  If the user clicks on a link, will they have a clear idea about where they 

will be linked to? Can the user tell easily what is a link and what isn’t? 

• Is the material within each subsection manageable? 

•Is it easy to navigate within a Web page?  Within your Web site? 

• Have you maintained a feeling of uniformity within your Web site?  If someone landed on any 

random page within your Web site, would they be able to tell it belonged to your site?  Does the 

layout have a uniform feel to it?   

 

Using Dreamweaver 

Dreamweaver is a web authoring program that uses a WYSIWYG “what you see is what you get” 

interface. The HTML code is being created and is accessible to you if you want to play with it. 

Finally, let’s get started with Dreamweaver. 

Launch Dreamweaver 
1. Start Dreamweaver. You should see a startup screen. 
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Dreamweaver lets you publish your Web site by easily uploading your Web site to a Web server.  Right 

now we won’t be worrying about that.  For now, you will be creating and viewing your site locally (which 

means the site will be located on your computer).  

We need to define your site: 

Create a New Site 
2. From the Site menu, choose Manage Sites… The Manage Sites Box should appear. 

3. Click New and then choose Site from the pop-up menu. 

4. Click on the Advanced Tab under Site Definition for Unnamed Site 1. 

Local Info  
Local Info is where we put in the information about the files that are on your local computer (which is 

where all your files are or will be for now). 

5. In the Advanced Tab, under Category, choose Local Info. 
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6. Next to Site Name, type: My First Dreamweaver Web site. You will use this name when you go 

into Dreamweaver to retrieve the files associated with this site. This name has to be unique 

within Dreamweaver. 

7. Next to Local root folder, click on the yellow folder icon to browse for where you want to store 

your web site on your local computer.  You may wish to create a new folder to sore your files in. 

I stored my Web site on F: (my flash drive) in a folder I called My WebSite. This is now your Root 

Folder 

 

8. Click DONE.  You should see a Files panel on the right side of your screen.  The Local View in the 

Files Panel will display all the files for your Web site that are in the Root Folder on your 

computer. 

 

Later we will add information about connecting to the server.  The Remote View shows which 

files have been uploaded to the server.   

9. Once we’ve entered all this information about local and remote servers, it will be set up for us 

next time we use Dreamweaver on this computer.  Unfortunately, it doesn’t work that way on 

lab computers.  If you move to another computer, you will have to set up your Web site on the 

new computer as well. 
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WHAT’S A ROOT FOLDER? 
The local root folder is where you will keep ALL the files for your web site. You can create subfolders 

under it, but consider it to be the parent of all parent folders. You’ll keep all of the files and subfolders 

for your Web site (including html pages, images, multimedia files, etc.) either in the root folder or a 

subfolder under the root folder.. 

Making your first Web Page: 
10. Under the File menu at the top, choose New. 

11. In the New Document dialog box, make sure you have Blank Page selected, the Page Type is 

HTML, and the Layout is <none>. 

 

12. Click Create.  You should now see a blank Web page in the Document Window. 

13. Under the File Menu, choose Save. 

14. In the Save As box, find your Web site folder and save your  file as index.html 

15. Click Save.  In the Files panel, you should now see index.html. Congratulations!  You’ve created 

your first Web page using Dreamweaver.  Unfortunately, it’s pretty boring at the moment. 

Save the Page 
RULES OF THUMB for naming web files: 

• Do not use spaces or special characters, such as those found about the number keys on the 

keyboard, in your file names. You can use dashes and underscores. (e.g., my_page.html) 

• Always use a 3- or 4-character file extension for every file you use on the Web. In the case of a 

regular Web page, always use .htm or .html. 

• Be very specific about capitalizing because most Web servers are case-sensitive. 

Give your Web Page a Title 
In the document toolbar, find the Title box. 

16. On the document toolbar, locate the Title field. 
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17. Type in a title for your page.  Feel free to be creative (but not indecent). Hit Enter. 

18. The title doesn’t show up on the page, but will appear in tabs and across the top of browsers. 

Adding Some Content Add Content to the Page 
19. In the Document window, type in a good title.  This one will be the head of your Web page. If 

you can’t think of anything, you can always use, “Aardvark Adoption Society of Delaware”. 

20. Add a subtitle.  Again, it can be anything you want.  If you’d prefer, it could be, “We speak for 

Aardvarks who can’t speak for themselves.” 

21. Now that you’ve got a good title, add some content.  Logically, it should go with the title.  Type 

one or two lines now for now.  We’ll add more later. (If you can’t think of anything, feel free to 

throw in some of the Aardvark content). 

Now let’s format the content: 

22. On the Web page, highlight the title. 

23. In the Property Inspector, click on the Format drop down arrow, and choose Heading 1. 

 

Note: If you do not see the Property Inspector, choose Window >> Properties. 

24.  On the web page, highlight the second line of text. 

25. From the Format menu on the Property Inspector, choose Heading 2. 

Note: When formatting your text, keep in mind that text sizes in HTML are relative sizes. This means that, 

when your page is viewed in a browser, the text size will depend on the default text size settings on each 

user’s computer. Relative sizes give users the ability to adjust the text size to suit their individual needs. 

This option is especially important for people with visual impairments, but it means that the appearance 

of your pages may vary from computer to computer. 

 

Playing with Font Properties 
26. Highlight the Subtitle.  Change the font size to 24. 
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27. Highlight any word on the page and click the Bold icon ( ) on the Property Inspector. The 

selected word appears bold. 

28. Highlight  the title click the gray square to the right of the Size popup menu in the Property 

Inspector. A grid of colored squares appears, and the cursor changes to an eye dropper. 

 

29. Click the eyedropper on the desired color. The field to the right of the color swatch reflects the 

code Web browsers need to correctly display the color you’ve chosen. 

 

30. Click anywhere on the page to deselect the text. The previously selected text appears in the new 

color. 

Alignment 
31. 1. Highlight the title and subtitle on the page.   

32. Click the Align Center button ( ) on the Property Inspector. The titles should now be centered on 

your page. 

Creating Lists 
33. First we need to add a list.   
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34. Type in a title for your list and then type in a list of items. Make sure there are at least 3 items in 

your list.  Make sure you hit return after each item. (Feel free to use a list from the aardvark 

homework if you can’t think of your own.) 

35. Highlight the list title and choose Heading 3 from the Format menu on the Property Inspector. 

36. Highlight the list items and click the Unordered List buttonon the Property Inspector.  

 

37. The items appear as a bulleted list. 

38. Now type in another List title and another list of items. 

39. Highlight the title and select Heading 3. 

40.  Highlight the rest of the items and click the Ordered List button on the Property inspector (next 

to the ordered list button). The items should now appear in a numbered list. 

41. Save your work. Get into the habit of saving your work regularly.  

Page Properties 
In this section you will learn how to set your page’s background color, as well as the default text and link 

colors. These settings differ from what you’ve done so far on the Property Inspector because they’ll 

apply to all the text and links on the page—not just a selected piece of text. 

42. From the Modify menu at the top of the workspace, choose Page Properties. 

 

43. To change the text color, click the bottom right corner of the text color box. 

44. Using the eyedropper, choose a color by clicking on any of the color swatches. 

45. Similarly, you can change the background color for the page using the Background color setting. 
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46. You can also change the color of links, active links, and visited links. An active link is a link just 

when the user clicks it. A color change lets the user know that s/he clicked on a link. A visited 

link is one that the user has already clicked on and visited. A color change lets the user know 

s/he’s already visited that link. 

47. Select “Links” from the Category menu at left, then make your selections for link, visited link, 

and active link colors as you did in Step 3. 

48. Click the Apply button to see how your color choices look on the index page. The Page 

Properties dialog box will remain on the screen. 

49. When you’re satisfied with the colors you’ve picked, click OK. 

Note: You can add a background image if you want.  Browse to find an image by the background image.  

See what it looks like. Now you know that’s an option.  We’ll talk about this option more later.  For now, 

go back to a solid color background. 

Note: If you changed the color for any text using the Property Inspector, those changes will override 

general page color choices. 

Web Page Preview 
As you create a page in Dreamweaver, the page may not look exactly like it would in a browser.  To 

preview the page in a browser: 

50. Choose File >> Preview in Browser >> iexplore or Netscape or press the F12 key. A web browser, 

such as Netscape or Internet Explorer, opens and loads the web page. 

51.  Take a look at your page to see how it will appear on the Web.  

52. When finished, close the browser and switch back to Dreamweaver. 

NOTE: Colored or underlined text can be mistaken for links. Choose your color scheme so that the links 

stand out from rest of the text. The text and links also should stand out from the background for 

readability. When selecting colors, keep it simple. Too many colors can be distracting or confusing. 

Adding Images 
Note: Any editing or resizing of an image should be completed before it is added to a web page. 

53. First you need an image.  Feel free to find one on your own that suits the theme of your web 

page.  If you don’t feel like it, I’ve included an image on my Web site that you can download. 

54. Next, add it to your Web page. 

55.  Place your cursor below the subheader in your document and press Enter twice. 

56. 2. Choose Insert >> Image. The Select Image Source dialog box will appear. 

57. 3. Using the dialog box, locate and select an image, then click OK. 



10 

 

58. 4. You will first encounter a prompt to add accessibility attributes: 

 

59. Type a brief description of the image in the Alternate text box, then click OK.  

60. Because you’re trying to use a file that lies outside your root folder (mywebsite), you’ll receive 

the following message: 

 

61. Click Yes. The Copy File As dialog box will appear. 

62. Click the Save button to place a copy of the image file inside your my website folder. 

63. The image will appear on your web page. 

64. Click the Refresh button on the Files panel ( ) and the image file will appear in the list of local 

files. 
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Delete an Image 
65. In the Document window, click on the image to select the image. 

66. Press the Delete key. The image disappears. 

67.  To reverse the deletion, use the Undo command. From the Edit menu, choose Undo. The image 

should re-appear on the page. 

Create a Second Page 
Next, you will create a second page for your Web site.  

68. From the File menu, choose New…The New page dialog box appears. 

69. Click the Create button. The new file will appear in the document window. 

70. Save your new page in the mywebsite folder as Page2.html 

71.  In the Title field, type an appropriate title for this page. We’ll eventually make it into a Calendar 

of Events Page, if that helps you decide on a title. 

72. Save your work. 

Page Planning: When planning your Web site, you will need to decide how to 

organize each Web page.What will be placed on each page. Divide your site into 

pages for simple access. If your readers want to read or print only a calendar of 

events, you don’t want them to have to print the entire site to see it. Your site 

planning will also include how the pages will be linked together. 

Page Navigation 
Now that we have two pages, you can link them together. We’ll link the index.html page to the 

Page2.html and vice versa.  It’s easy in Dreamweaver! 

73. Use the tabs on the Document toolbar to toggle back to the index page. 

 

74. On the index page, type some descriptive text that describes your Page2.html.   

75. Highlight the text you want to make a link. 

76.  In the Property Inspector, click on the Browse for File icon to the right of the link box. A Select 

File dialog box appears. 
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77. Using the dialog box, locate and select the file Page2.html. 

 

78. Click the OK button.  Cool!  You just made a link! 

79. The selected linked text is underlined and appears in the link color you chose. In the Property 

Inspector, the Link field reads: “Page2.html 

80. Save your work and preview the page in a browser. 

81. Test the link. When finished, return to Dreamweaver. 

82. Now, try linking Page2.html back to the index page. 

83. Save your work and test the new link in a browser. 

Note: The text you use for your link should be brief but descriptive, giving your visitors an idea of where 

the link will take them even before they click it. 

Let’s compare:           click here for more information            lacks detail. 

Compared to              Calendar of Upcoming Events             , which is clear and concise. 

84. Link to a Web Page 

85. Next let’s add an external link.  By that I mean let’s link to a Web page that is located 

somewhere on the World Wide Web.  We’ll need to use the full  (absolute) URL to link to this 

page. 

86. Go to the bottom of your index.html page and type “More info on Aardvarks”. 

87. Highlight the text you just typed. 

88. In the Link box in the Property Inspector, type http://en.wikipedia.org/wiki/Aardvark/  and press  

Enter. 
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89. The text you selected should now link to Wikipedia’s web page on Aardvarks. To make sure the 

link works properly, preview the page in a browser. 

90.  Switch back to Dreamweaver to continue editing your page. 

Add an E-mail Link 
Now you’ll make your e-mail address a link so that visitors can send you questions and comments via 

email. 

91. At the bottom of your page, type “Send me an email” and highlight the word email. 

92. From the Insert toolbar (across the top, below File Edit, etc.), click on the envelope icon  to 

insert an email link. 

93. Place your cursor in the E-mail box and type your email address: 

94. Hit OK. Your e-mail address appears as a link. 

95. Save your work. Please note that the email link will try to open a desktop email program if you 

have one on your computer. However, if the computer you’re working on doesn’t have an email 

program set up, testing this link won’t work. 

Note: One of the advantages in creating a course Web site is adding appropriate links to other sites on 

the Web. You may want to compile a list of links that support your instructional goals. This allows you to 

supplement your page with appropriate Web resources. Plus it’s always fun to look around at other 

relevant pages to learn new things about your topic and create your own relevant Webliography. 

Creating a Link within a Page    

Create the Target of the link 

96. Place your cursor at the top of your page 

97. Choose Insert >> Named Anchor. The Named Anchor dialog box will appear. 

98. In the Anchor Name box, type a name for the anchor. This should describe the content in that 

section of the page. 
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99. Click OK. A yellow anchor will appear just before the text. If the yellow anchor symbol does not 

appear, then choose View >> Visual Aids >> Invisible Elements. 

Create a link to the anchor 
100. At the bottom of the page, type “Back to Top”. Highlight this text. 

101. On the Property Inspector, click on the point-to-file icon to the right of the Link field and 

drag it to the schedule anchor symbol. (You literally click on it and, without releasing the 

mouse, drag it over the anchor symbol in your Web page). 

As the arrowhead moves over the anchor, the anchor name preceded by the pound sign (#) will appear 

in the link field. The selected text is now a link, and is underlined with a different text color. 

The form that this type of link uses is different from a standard link. In the link field, a pound sign 

appears followed by the name of the anchor. The # (pound sign) indicates that the link is to an anchor 

on the Web page. 

Note: When planning your Web site, you will need to decide how to organize links between all the pages. 

A good practice is to place links to other pages at the top and the bottom of each page. Also, each page 

should be linked to your home page (index.html). 

Page Layout with Tables 
We can use Tables to lay out the format of text and images. A table has rows and columns and may be 

used for layout in a number of ways, including placing text or images side by side on a page. In this 

section, you’ll make a table that shows the Calendar dates and events for an Aardvark Sanctuary. 

Create a Table 
102. Place your cursor at the top of Page2.html after the text. Now, you’ll insert a table with 3 

rows and 2 columns. 

103. From the Insert menu, choose Table. The Table dialog box appears. 

104. Under Table size, adjust the settings as follows: 

Rows = 3 

Columns = 2 

Table width = 75 % 

Border thickness = 1 
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105. Click OK. The table will appear on your page. 

 

106. Place your cursor in the upper-left cell of the table and type: “Schedule of Events” 

107. On the second row, in the left-hand cell type: Date 

108. Press the [Tab] key to move to the next cell in the table. 

109. Type: Event  

110. Press the [Tab] key again to move to the next row. 

111. Type in a date. Move to the next cell, and type in a description of an event. As you type in a 

long paragraph, the words wrap within a cell. 

 

112. Press the TAB key, and a new row is automatically added to the table. Enter the date and 

event description in the fourth row. 

Merge Cells 
We want the Schedule of Events to be centered across the entire table.  To do that, we first need to 

merge the two top cells in the table. 

113. Click and drag your cursor from left to right across row 1. You’ll now merge those two cells 

into one. 

114. Choose Modify >> Table >> Merge Cells. Now, in row 1, you should see one large cell. 

Insert an Image 
115. Place your cursor in the right-hand cell of the last row. Press the [Tab] key to add a new row. 

116. Place your cursor in the right-hand cell of that new row. Choose Insert >> Image. The Select 

Image Source dialog box appears. 

117. Navigate to an image – either one you’ve downloaded and is on your flash drive or one from 

my Web site that you can download.    
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118. Click OK. The image you chose will appear in the table cell. 

Add a new row to the table. 
After you have created a table, you may need to add information in the middle of the  table. You can 

add rows or columns to expand the table. 

119. Click in the third row of your table. 

120. Choose Modify >> Table >> Insert Row. 

A new row appears in the table. 

121. Click in the second column of the new row and insert another image (your choice). The image 

appears in the cell. 

122. Click in the cell to the left of the image and type some relevant information in the cell. 

Delete a row 
The table can also be adjusted by removing unnecessary rows or columns. 

123. Click in the second row of your table. 

124. From the Modify menu, choose Table, and then choose Delete Row. The row and its contents 

are deleted.e Table 

Resize columns and rows 
Depending on the content you add to your table you might find that columns are too wide or narrow. 

You can adjust the column width to better fit the content in your table. 

125. Place the cursor over the line dividing the columns. The cursor turns into a two-headed 

arrow. 

126. Click and drag the two-headed arrow toward the right to the middle of the table. The 

columns are re-sized. 

127. Place the cursor over the right side of the table. Click and drag the two-headed arrow to re-

size the table again. 

128.  Save and preview the page. 

Try changing the size of the browser window. Notice that the table size changes as the browser window 

size changes – why? The reason the table size is not constant is because the width of the table is 

expressed as a percentage of the total width of the browser window, in this case, 75%. If you wish to 

lock the table to a specific size, you have to express the table dimensions differently. 

Table dimensions can also be expressed as fixed using “pixels”. A pixel is a single point in a graphic 

image. Screens are divided into thousands (or millions) of pixels, arranged in rows and columns. On a 
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Web page, a recommended pixel size for a table’s width would be no higher than 600. (Assuming a 

screen resolution of 800 x 600). 

When your table is selected, you can view and change the table width on the Property Inspector (as 

shown below). 

 

Experiment with cell color and other options 
129. To add background shading to a cell or row, select the cell(s) and click on the bottom corner 

of the Bg color box on the Property Inspector 

130. Click on a swatch with the eyedropper to choose a color. 

 

131. Try various formatting options for the rest of the table using the Property Inspector. Change 

the size, color or style of the text, and try the alignment options. 

132. Save your work and preview.  

Congratulations.  You have completed your introduction to Dreamweaver CS3.  Of course, as usual, 

we’ve barely touched the potential of Dreamweaver.   

To turn in: 
• The two html pages you created. 

• The images you included in your Web Site. 


